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Fejlesztõi sarok

Bevezetés az Eclipse
nézeteinek, szerkesztõi-
nek és beépülõ modul-
jainak világába.

következõkben bemutatjuk
az Eclipse platformra épü-
lõ alkalmazásfejlesztési

környezetekhez tartozó beépülõ
modulok (pluginek) fejlesztésének
praktikáit. A cikkben található általá-
nos alapelvek a letölthetõ verzión
túl számos Eclipse alapú fejlesztési
környezetre érvényesek. A fejlesztési
folyamat több szempontját is érint-
jük, például a nézet kontra szer-
kesztõ vitát, a belsõ vagy külsõ mód
kiválasztását, a szabványos widget

eszközkészlet (Standard Widget

Toolkit – SWT) alapjait, az Eclipse

beépülõmodul-varázslójának (Plugin

Wizard) hasznosságát. Az Eclipse

beépülõ modulok Eclips-szel való
fejlesztésének elõnyeit is tárgyaljuk.
Egy egyszerû beépülõ alkalmazás-
modul fejlesztésének lépéseit is
végigkísérjük, nem tévesztve szem
elõl a más modulokban való újra-
hasznosítás lehetõségét.

A nézet kontra szerkesztõ vita
Az Eclipse-ben kétféleképpen tálal-
hatjuk az információt a felhasználó

számára: nézetben vagy szerkesz-
tõben. Mindkettõ lehetõvé teszi,
hogy a beépülõ modul egyes mûve-
leteit végrehajtsuk az elemeken,
szimpla vagy dupla kattintással,
illetve a jobb kattintásra elõugró
menübõl vagy a fõmenübõl való
kiválasztással.
A szerkesztõ osztály gyakorlatilag
mindent tud, amit a nézet, sõt, sokkal
többet. Az extra funkciók azonban
nincsenek ingyen, sem a rendszer,
sem a kód bonyolultságát tekintve.
A szerkesztõ osztály fejlesztése álta-
lában több munkát igényel, mint
a nézet, így a munka megkezdése
elõtt nem árt elgondolkodni azon,
érdemes-e.
Ha az információk egyszerû megjele-
nítése és néhány beépített tulajdon-
ság kihasználása a cél, akkor a nézet
elegendõ. A nézetbe egyszerûen
vihetünk be adatokat, többnyire az
SWT widgetjeivel, például tábláza-
tokkal és szövegablakokkal. Mi van
azonban akkor, ha egy sokkal szaba-
dabb formájú kapcsolatot kívánunk
megvalósítani a felhasználóval?
Hogy oldjuk meg az Eclipse több-
szöri indításánál is fennmaradó
felhasználói adatbeviteleket?
A vitában az egyik jó érv a per-
szisztencia kérdésének felvetése.
Bár van rá lehetõség, hogy egy nézet-
bõl adatokat nyerjünk ki, valamiféle

perszisztens tárolóból, ez többnyire
némi fájlokkal, vagy fájl-szerû kontex-
tusokkal való munkát jelent. Ebben
az esetben gyakran egyszerûbb
szerkesztõt készíteni.
A második leggyakoribb szempont
a megjelenítendõ adat. Ha a felhasz-
nálónak többféle adat kiválasztására
szeretnénk lehetõséget adni úgy,
hogy ezeken egyesével végezhessen
mûveleteket, akkor a mûveletek
megvalósítása rendszerint külön
nézetben egyszerûbb.
Néhány sorral késõbb implementálni
fogunk egy nagyon egyszerû Eclipse

beépülõ modult, amelynek egyetlen
célja, hogy alkalmazásszintû adatokat
biztosítson a felhasználónak. Az ada-
tokat karakterláncként jelenítjük meg,
de ezt lényegében bármivel helyette-
síthetnénk. Engedélyezzük a szokásos
bal, jobb és dupla kattintást, de csak
ez utóbbit módosítjuk a többi mûve-
let implementálásában való újrahasz-
nosítás szemléltetésére.
Mivel nincs szükségünk perszisztens
erõforrásra, és az adatokat egyesével
akarjuk kiválasztani, ugyanazt
a beépülõmodul-funkciót nézetként
valósítjuk meg, amelyet egyszerûen
DataView-nak hívunk.

A belsõ vagy külsõ mód kiválasztása
Mielõtt eldöntjük, hogy nézetet
vagy szerkesztõt fejlesztünk, még

Bõvítmények fejlesztése 
Eclipse-hez
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egy kérdésre kell felelnünk:
a felhasználó számára megjelení-
teni kívánt adatokat az Eclipse kör-
nyezeten belül vagy kívül tároljuk?
Az SWT-ben lévõ Form osztályok
lehetõvé teszik, hogy az alkalma-
zás adatait külsõvé tesszük („exter-
nalizáljuk”).
A szerkesztõk lehetnek külsõk
és belsõk egyaránt, azonban a kül-
sõ szerkesztõnél nehéz hozzáférni
a beépülõ modulhoz. Egyes beépü-
lõ modulok meglepõ módon épp
ezt a funkcionalitást támogatják.
A legtöbb esetben ennek az az
oka, hogy a gyártók a felhasználó-
kat kizárják a beépülõ modulok
bizo nyos szintû Eclipse-funkcióinak
használatából. Nagy általánosság-
ban – az eszközökben lévõ nyitott-
ságról szóló felhasználói viták el-
lenére is – azt mondhatjuk, hogy
az Eclipse szerkesztõket belsõként
kell megvalósítani. Egyszerûen
nincs értelme lemondani a be-
épülõ modul egyéb funkcióiról,
ha nem muszáj. De mi a helyzet
a nézetekkel?
A szerkesztõkhöz hasonlóan
a nézet is megvalósítható külsõként,
külön Form osztállyal, és belsõként
is, mint egy szokványos nézet, járu-
lékos widgetekkel. Nincsenek kõbe
vésett szabályok, de a választást
megkönnyíthetjük néhány alap-

elv észben tartásával. Általában
két dolgot kell figyelembe ven-
nünk: tekinthetjük-e a nézet adata-
it olyan, egyedi, egymástól elkülö-
nült elemeknek, amelyek mezõi
vagy mûveletei az egyes adatokra
jellemzõk, illetve úgy kilencnél keve-
sebb van-e ezekbõl az elemekbõl?
Ha igen, táblázattal, esetleg ele-
menként külön füllel, nézetként
megvalósítható.
Ha azonban az adatelemek és a raj-
tuk végezhetõ mûveletek tényleges
száma változó vagy ismeretlen – pél-
dául mert a fejlesztõnek nincs elõze-
tes ismerete arról, hogy hány elem
várható, mennyi különféle mûveletet
kell támogatnia, illetve engedélyeznie
a jövõben, – a legjobb, ha a nézetet
külsõ Form osztályként valósítjuk
meg.
A mintául szolgáló beépülõ modul
egy egyszerû, 100 elemû implemen-
táció, amely mindegyik adatelemet
két mezõvel, névvel és értékkel
jelenít meg. Bár a kilencnél több
mûvelethez nincsenek elõre definiált
rendszerkövetelmények, nincs több
mûvelet sincs megadva. Ennek
megfelelõen azt is feltételezhetjük,
hogy ilyenekre nem kifejezetten lesz
szükség – elvégre egyszerû példát
szeretnénk bemutatni. A DataView

beépülõ modult tehát belsõ nézetként
implementáljuk.

Ismerkedés az Eclipse környezettel
A beépülõ modul fejlesztéséhez
elõször az Eclipse-et kell telepíteni.
A példa kedvéért az Eclipse

weboldaláról letöltöttük az Eclipse

legfrissebb változatát, amely a cikk
írásának idején 3.0.2 volt (Az Eclipse

SDK 2007. január 22-i verziója 3.2.1. –
a ford.)). Mivel saját munkahelye-
men a CDT-t használom a C és
C++ fejlesztésekhez, a CDT projekt
2.1-es változatát is letöltöttem, ami
az Eclipse weboldalának projects

ugrópontjáról elérhetõ Eclipse Tools

Projectben található meg. Mindkettõ
elérhetõ .zip fájlként, amelyek ki-
csomagoláskor a /eclipse könyvtárba
kerülnek, ezért figyeljünk arra,
hogy elõször az Eclipse csomagot
telepítsük. Én Red Hat Linux 9.0-át
használok az Eclipse keretrendszer
és a CDT GTK-s verziójával,
de a Motifos verziók is ugyanolyan
jól mûködnek. Ezután már elindít-
hatjuk az Eclipse-t a ./eclipse

paranccsal, és a Windows > Open

Perspective menüpontból kivá-
laszthatjuk a beépülõ modul
fejlesztésére szolgáló perspek-
tívát (Plugin Development

Environment – PDE).

Az Eclipse beépülõmodul-varázslójának használata
Az Eclipse beépülõ moduljainak fej-
lesztésérõl szóló írások közül sok
csak a „Helló Világ” típusú példán
vezeti végig a felhasználókat. Nem
kizárt, hogy ez jó kiindulási alap
lehet kezdõ fejlesztõknek, de hitem
szerint, nincs ennél rosszabb módja,
hogy a gyakorlott szoftverfejlesztõk
megismerkedjenek az Eclipse-szel.
Túl sokáig tart, és ami ennél is kelle-
metlenebb, szinte az egészet elölrõl
kell kezdeni, ha egy valódi beépülõ
modult kell készíteni. Ehelyett azt
javaslom, hogy amennyire csak lehet,
teljes beépülõ modult készítsünk,
a meglévõ sablonokból annyit fel-
használva, amennyit csak a kör-
nyezet megenged. Ha így teszünk,
rögtön számos funkció áll majd
a rendelkezésünkre, amelyek
testreszabása anélkül elvégezhetõ,
hogy a normál beépülõmodul-
környezethez való megfelelõ
kapcsolódás miatt aggódni kellene.
A PDE beépülõmodul-varázsló-
jával egyszerûen készíthetünk

1. ábra Új beépülõ modul készítéséhez indítsuk el a varázslót a  File > New > Plug-in
Project menüpontban
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beépülõmodulprojekt-mintát,
a File > New > Plug-in Project

menüpontban. A névválasztásnál
a más gyártók által is használt
konvenciót követjük:
com.vállalatNeve.termékNeve, ami
a jelen példában com.mcc.dataView,
ahogy az 1. ábra is mutatja.
Ha már a testreszabásnál tartunk,
meglehetõsen egyszerû feladat
egyes funkciók eltávolítása, így a kö-
vetkezõ két képernyõt átugorjuk, és
a sablonokkal folytatjuk. Kiválasztjuk
a Create a plugin-t az egyik sablonnal,
és a Custom Plugin Wizard-dal,
majd a Next gomb megnyomására
már láthatjuk is a létrehozni kívánt
sablonokat.
Már ezen a ponton is eltávolíthat-
nánk funkciókat, de ebben a példá-
ban ezt nem tesszük. Ehelyett addig
nyomkodjuk a Next gombot, míg
a Main View Settings panelhez nem
érünk, ahol a nézetmintát átnevez-
zük DataView-ra, a 2. ábra szerint.
Ha mindent megfelelõen beállítot-
tunk, a Finish-sel befejezhetjük
a mûveletsort, de végiglépkedhetünk
a testreszabás utolsó lépésein is (View

Features). Minden képernyõnél szaba-
don léphetünk egy elõzõ vagy követ-
kezõ stádiumba, úgyhogy nyugodtan
próbálgassuk a lehetõségeket.
A Finish gomb megnyomásáig
semmiféle változtatás nem történik
a környezetben.
Ha az elsõ próbálkozás nem sike-
rül, ahogy például nekem sem sike-
rült, ne keseredjünk el. Töröljük
az egész projektet, a könyvtár tartal-
mával együtt, és csináljuk mindad-
dig újra, amíg nem sikerül. Mihelyt
a beépülõ modul elkészül a követel-
ményeink szerint, máris futtathatjuk,
amihez a futásidejû munkapadot
használjuk.

A beépülõ modul tesztelésea futásidejû munkapadon
Az Eclipse keretrendszer egyik
legnagyszerûbb tulajdonsága,
hogy a beépülõ modulokat a saját
futásidejû munkapadján fejleszt-
hetjük, tesztelhetjük és javíthatjuk.
Nagyon kevés fejlesztõi környezet
kínálja ugyanezeket a lehetõsége-
ket, ilyen könnyen és intuitívan
kezelhetõ módon. Más eszközökkel
a fejlesztõk gyakran sok idõt po-
csékolnak el a fordítás, szerkesztés

és hibakeresés ciklusának hossza-
dalmas ismétlésével.
A DataView beépülõ modul végre-
hajtásához egyszerûen válasszuk
a Run > Run As > Run-time

workbench menüpontot a PDE pers-
pektívából. A PDE erre létrehoz egy
teljesen elkülönült munkaterületet,
amit futásidejû munkaterületnek is
hívunk, és végrehajtja a DataView

beépülõ modult. Az elsõ futtatáskor
a Window > Show View > Other

menüpontra is szükségünk lesz,
ahol a beépülõ modul létrehozása-
kor kiválasztott nézetek alatt lévõ
DataView-t is ki kell jelölnünk.
A futásidejû munkapad a szokásos
munkaterülethez hasonlóan mûködik,
így megõrzi a nézet tulajdonságait
az egyes indítások között. Ez nagy-
mértékben leegyszerûsíti a tesztelést,
mivel az ismételt ellenõrzéshez
mindössze újra el kell indítani
a futásidejû munkapadot.
A futásidejû munkapad modelljének
kevés hátránya közül az egyik az,
hogy közel megduplázza a memória-
felhasználást, mintha két Eclipse-t
használnánk ugyanazon a számítógé-
pen. Kevés memóriával ellátott eszkö-
zökön, például hordozható számítógé-
peken ez a sebesség nagymértékû
csökkenése miatt zavaró lehet. A Java
virtuális gépek folyamatos javulásával
azonban ez is egyre kisebb gond lesz.

Kísérletezzünk kicsit a beépülõ mo-
dul menüivel, legördülõ menüivel,
hogy lássuk, milyen funkciókat
hoztunk létre. Bár a szerkesztõk
testreszabását nem tárgyaljuk, érde-
mes lehet idõt szakítani egy .mpe

kiterjesztésû fájl elkészítésére is,
egy egyszerû Eclipse projekt kereté-
ben. Ennek segítségével a kíváncsi
olvasó megismerkedhet a többoldalas
szerkesztõk világával, amilyen pl.
az új beépülõmodul-projektben
található plugin.xml fájl megjelení-
tésénél is látható.

A beépülõmodul-nézet testreszabása
A DataView tesztre szabásának elsõ
lépéseként egy új ViewLabelProvider

osztályt kell hozzáadnunk a Views

könyvtárban lévõ beépülõmodul-
projekthez. Ezzel adatokat adhatunk
a táblához, amit a beépülõ modul
a DataView ablakban futás közben
megjelenít. A ViewLabelProvider

osztály a tárolt adatot, egy nevet és
egy értéket, átadja a DataView-nak,
a ParameterControl osztály segít-
ségével. Ezt az osztályt teljes terje-
delmében a projekt tar állományában
találjuk.
A következõ lépés
a ViewLabelProvider osztály által hi-
vatkozott ParameterControl osztály
hozzáadása a Views könyvtárban lévõ
beépülõmodul-projekthez, amely

2. ábra Adjunk nevet a beépülõ modulnak a Main View Settings ablakban
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a DataView táblájában megjelenítendõ
tényleges paraméterek nevének és
értékének kezeléséért felelõs. Bár ez
egy viszonylag egyszerû implemen-
táció, szükség esetén könnyedén
kiterjeszthetõ nagy számú mezõre is.
Ennek az osztálynak a leírását is
a projekt tar állományában találjuk.
Harmadik lépésként hozzáadunk
a DataView osztályhoz egy táblát
a megfelelõ beállításokkal (lásd az
1. tételt a Linux Journal FTP-helyén),
módosítjuk magát a Plugin osztályt
a UserParameter változó támogatásá-
hoz és a DoubleClick eseményhez
hozzárendeljük a táblában lévõ ada-
tok megjelenítését. Vegyük észre,
hogy egy új függvényt, az
UpdateTheTable-t is létre kellett hozni,
hogy a táblában mindig a legfrissebb
adatok szerepeljenek. Ha új alkalma-
zásadatokhoz kell hozzáférnünk a fájl-
rendszeren, a hálózaton keresztül
vagy valahogy máshogy, ezt a függ-
vényt kell módosítani. Példánkban
az elsõ négy paramétert változtattuk
meg. A beépülõ modul teljes kódja
a Linux Journal FTP-helyérõl letölthe-
tõ (lásd a kapcsolódó anyagokat).
Az utolsó lépésben a beépülõ modul-
ban létrehozzuk a ParameterControl
változót és kezdõértékkel látjuk el. Ezt
a DataViewPlugin.java fájlban, közvet-
lenül a resourceBundle deklarációja
után tegyük meg, a következõ módon:

//User Parameter functionality
public ParameterControl 
�userParameters[] = 

new ParameterControl[100];

Végül a kezdeti értékadás következik
a Plugin konstruktora után:

// Additions for User Parameter 
�functionality
int index;
for (index = 0; index < 100; 
�index++)
{

userParameters[index] = 
new ParameterControl
�("Parameter "
+ (index + 1), "Value " 
�+ (index + 1));

}

A 3. ábrán a beépülõ modul
végrehajtása látható a futásidejû
munkapadon. Az ábrán azt látjuk,
amikor a felhasználó duplán kattin-
tott egy elemre, aminek hatására
a táblában kiválasztott elem adatai
megjelennek egy egyszerû párbe-
szédablakban. 

Összefoglalás
A cikkben áttekintettük azokat
a fõbb alapelveket, amelyeket az
alkalmazásadatok megjelenítésére
szolgáló, nézetként megvalósított

Eclipse beépülõ modul fejlesztésé-
nél figyelembe kell vennünk.
Felhasználtuk az Eclipse beépülõ-
modul-varázslóját az inicializációs
kód jelentõs részének automatikus
létrehozásához, tesztelhetõ és újra-
hasznosítható módon. Az SWT fel-
használásának néhány példáját is
áttekintettük, például Table, Viewer

és LabelProvider, illetve ezek alkal-
mazását a felhasználói nézetben.
Végül rámutattunk az Eclipse

futásidejû munkapadjának egyes
elõnyeire és hátrányaira.
Mindeközben létrehoztunk egy
egyszerû, mintául szolgáló beépülõ
modult, amely újra és újra felhasz-
nálható az új modulok kiindulási
alapjaként. A jövõbeli igények ki-
elégítésére bekapcsolható az összes
jellemzõ funkció, például a több-
oldalas szerkesztõk, tulajdonságok,
varázslók és referenciakiterjesztések.
A további képességek már iteratív
módon is fejleszthetõk, ami nem
csak az adott beépülõ modul jövõ-
beli növekedését teszi lehetõvé,
de a különféle modulok fejleszté-
sében való újrahasznosítását is.
Az Eclipse-t egyáltalán nem vagy
csak kevéssé ismerõ fejlesztõk
számára is jó kiindulópont lehet.
Az újrahasznosítás az Eclipse

keretrendszer egyik legfigyelem-
reméltóbb sajátossága.
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3. ábra Az elkészült beépülõ modul reakciója a felhasználói inputra

Mike McCullough az MCC
Systems elnöke és ügyvezetõ igazga-
tója. A Bostoni Egyetemen megsze-
rezte a számítógépek tudományának
baccalareusa és a rendszertervezés
magisztere címeket. Számos posztot
tud maga mögött a Wind River
Systems, Lockheed Sanders, Stratus
Computer és az Apollo Computer
cégeknél, egy 20 éves múlttal rendel-
kezõ elektronikai veterán. Az MCC
Systems Eclipse alapú szoftverfej-
lesztési eszközöket készít és a be-
ágyazott rendszerek témakörében
kínál oktatási és konzultációs
szolgáltatásokat.
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